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Acrobat 
Forms Every law office uses forms. 

Forms are useful for obtaining information. 

The problem with forms is that many offices still 
open a form, print it out, and then fill it in either 
by hand or by typing the necessary information.



Acrobat 
Forms

Adobe Acrobat allows you to create 
fillable forms from existing PDF 
documents.

Adobe Acrobat eliminates the 
hassle of forms by allowing users to 
transform virtually any document 
into a form that can be filled out or 
into a form that can be used over 
and over. 



Acrobat 
Forms

By converting a static form into one 
with fillable form fields, you can avoid 
typing all of the firm and attorney 
information every time, and save time 
in the process.

Static forms could originate from an 
outside source, from a Word 
document, or even from inside 
Acrobat.



Why Do You Need This Program?

“You fixed the text 
boxes so they don’t 
just go in one long 
line. Thank you thank 
you thank you!”

Email to Dan 



Converting PDF Files 
to Interactive Forms

You can convert any type of PDF into a fillable form. First, 
open your PDF file and from the Tools pane, select 
Prepare Form.
• Acrobat will offer three options: Single File, 
Scanner or Create New. 
• Generally, Acrobat displays the document you are 
working on and its name above the Change File 
option. 
• If this is the correct document, click Start. If you 
select Change File, you can use Windows File Explorer 
or Mac Finder to browse and locate the file you want 
to convert into a form. When the correct document is 
displayed, click Start.
• If you select “Scanner,” the Start button becomes a 
Scanner interface appears. Once you scan a 
document, Acrobat will begin the process of creating a 
form. Finally, “Create New” will open a new blank 
document, which can be used to create a form “from 
scratch.”



Converting 
PDF Files to 
Interactive 
Forms

Note: We recommend scanning and saving any paper 
documents you want to convert into a form before 
attempting to create a fillable form. This will allow you to 
create the form and then work with it, discarding any 
changes if you discover that you need to start over.

After you select Start, Acrobat will analyze the document and 
add form fields where it feels they are appropriate based on 
the text of the document and its analysis of locations with 
blank lines. 

Note: This autodetection is set by default. You can check this 
default setting, and change other settings, by modifying 
Forms preferences in Edit>Preferences>Forms for Windows 
or Acrobat Pro DC>Preferences for Mac.



Converting PDF Files to Interactive 
Forms
The Prepare Form toolbar appears above your document, and 
the Forms pane will display to the right. The Prepare Form 
toolbar contains the tools for creating different types of 
fields, the Pin tool, a Help button, and a Preview button, 
which allows you to view the form as it will display to an end-
user and then easily go back into Edit mode. 
• The Forms pane displays a list of the fields that Acrobat 
has added. Adjacent to the FIELDS title are two dropdown 
menus. The right dropdown sorts your tabs (form fields) 
alphabetically or in tab order. The left dropdown menu is the 
Reading Order tool, which allows you to specify in what order 
a user will go as they move between tabs. If you enable 
Show Tab Numbers, it may be easier to arrange tabs as you 
edit the document. You can sort (Order) the tabs (form 
fields) to make it easier for the end-user by Structure, by 
Row or by Column. 



Converting PDF Files 
to Interactive Forms

When you review the document and the 
form fields that Acrobat has inserted, you 
will likely note that Acrobat has inserted 
fields where you do not need them or has 
not inserted them where you do. You can 
manually add form fields by using the tools 
on the Prepare Form toolbar or by right-
clicking on the document and choosing one 
of the field types from the menu. You can 
easily delete fields by selecting the field 
and pressing the Delete key or by right-
clicking on a field and choosing Delete.
• NOTE: If a document has been password 
protected to prevent editing, or Reader-
Enabled, you will not be able to add or 
modify the existing fields.



Types of Form Fields
Edit Text & Images: This allows 

editing of text and images.
Add Text: This tool allows you to 

add text directly to the file.

Text Field: This tool allows users to 
type alphabetic or numeric 

characters.

Check Box: This tool presents 
choices for the user; multiple check 

boxes can be selected if the form 
allows it.

Radio Button: This tool presents 
choices for the user; only one radio 

button can be selected (for example, 
to choose yes or no).

List Box: This tool displays a list of 
options a user can select; you can 

enable a user to select multiple 
items from the list.

Dropdown List: This tool allows a 
user to choose an item from a pop-

up menu.

Button: These action buttons allow 
a user to perform functions such as 

to Print, Reset, or Submit a form. 
They can also be used to perform 
other actions, such as moving the 
user to a specific page, opening a 

file, or opening a web page.

Image Field: The image field allows 
the user to select an image to 

upload and include in the document. 

Add a Date Field: The Add a Date 
Field is the same as a Text Field that 
requires the user to input a date in a 

specific format, without the extra 
steps.

Digital Signature: This tool allows a 
user to digitally sign a document.

Barcode Field: This tool encodes the 
data that is inputted on a form and 
creates a barcode. This field is not 
likely to be used by attorneys and 
will not be discussed in this book.



Using Text Fields

Most legal professionals will use text fields in every 
document. Learning how to create and modify them 
is crucial to creating documents that not only look 
good but are also user-friendly.
• To add a text field, choose the Text Field button 
from the Prepare Form toolbar or right-click on the 
document and choose Text Field from the menu. 
Place your cursor on the page where you wish the 
field to appear and left-click. A box will appear that 
will prompt you to add a Field Name. A default name 
such as “Text1” will appear in the box. You should 
not keep this default name, but rather, add a 
descriptive, meaningful name for the field. 



Using Text Fields
• NOTE: If fields have the same name, 
when users type into the field, the text 
they type will populate in the other 
fields with the same name. This can 
be useful if the form has areas where 
text needs to be repeated (such as a 
name, address, birthdate, etc.) but 
you may not want data to reappear. 
Be careful when naming your fields to 
choose unique names that are not 
already in use in the document.



Using Text Fields

NOTE:
• If you check the box for 
“Required field,” the user must fill 
in the field.
• If the field is not properly sized, 
you can drag the handles on the 
field to the correct size.
• You can open the Text Field 
Properties box by double-clicking 
on the field or by right-clicking and 
choosing Properties. There are 
eight tabs that contain various 
properties that you can modify. 



Using Text Fields

• General Tab: This tab displays the current name of the field, 
a Tooltip box, and options for whether to make the field Read 
Only or Required, whether the field should be visible either in 
screen or in print, and to rotate the field. Making a form field 
required will not allow a user to submit a form without adding 
information to the field. Adding text to the Tooltip will display 
text over the field when a user’s mouse pointer hovers over it. 
This device aids a user in knowing exactly what information, 
and in what format, should be typed in the box.

• Appearance Tab: This tab determines whether the field has a 
border or a fill color, the properties of the border such as color 
and thickness, and in which font and font size the text a user 
types will display. 

• Position Tab: This tab determines the placement of the field 
on the page in terms of inches, points, etc. This property can 
be used to ensure that your fields are aligned or that they are 
in the same position as other text on the page. 



Using Text Fields
• Options Tab: This tab determines the alignment (Left, Center, Right) 

of the text a user types as well as whether the text is spell checked. 
You can limit the number of characters that can be typed and allow 
for multiline or scrolling of long text. The multiline option allows 
users to type hard returns in their text. Scrolling will allow a user to 
type a long string of text but will not allow for hard returns. If a user 
types a string of text that exceeds the box, the text that exceeds the 
field’s dimensions will not be visible in the field. By checking the box 
to Allow Rich Text Formatting, you can enable your users to add 
formatting such as bold or italics to their text. 

• Actions Tab: This tab allows you to associate actions with the form 
field such as moving the user to a specific page, opening a file, or 
opening a web page. You can also use an action to submit the form 
when the user completes the final field. To add an action, you 
choose the trigger (Mouse Down is a click, Mouse Up is releasing 
after a click, Mouse Enter is moving the pointer over the button, and 
Mouse Exit is moving the pointer away from the button) and then 
use the Add button to add the desired action. Although you can use 
this feature with a text field, it is more commonly used when 
inserting an action button.



Using Text Fields
• Format Tab: This tab automatically formats the information a 

user enters in a specific way.
• None: This option applies no formatting.
• Number: This option provides number formatting options 

similar to those found in Microsoft Excel for decimal places, 
separators such as commas and periods, currency symbols 
and locations of those symbols, and negative number style 
(with or without parentheses or red text).

• Percentage: This option provides formatting options for 
decimal places and separators such as commas and periods.

• Date: This option provides formatting options for various date 
styles, such as m/d, mm/dd/yy, or yyyy-mm-dd. You can 
also use a style that combines date and time if you need to 
display both.

• Time: This option provides formatting options for various time 
styles, such as HH:MM or h:MM:ss tt (where tt is the a.m. or 
p.m. indicator). If you need to combine date and time, you 
should use the Date formatting option.

• Special: This option provides formatting options for Zip Code, 
Zip Code +4, Phone Number, and Social Security Number.

• Custom: This option provides further options using 
JavaScripts. Most lawyers will not need this option.



Using Text Fields

• Validate Tab: This tab restricts entry in a text field 
to specified ranges, values, or characters. If you 
choose to use a number or percentage format, for 
example, on the Format tab, you can limit the entry 
to numbers within a certain range. The option to 
limit the range is grayed out when it does not apply 
to your Format style. 

• Calculate Tab: This tab performs mathematical 
operations on field entries and displays the result. 
You can easily display the sum of the value of 
various fields, or the product of various fields. This 
can be used for expense reimbursement forms 
where you can easily calculate the amount to be 
reimbursed by multiplying a predefined mileage rate 
by the number of miles a user inserts in a form.



Adding Digital Signatures to a Form

• A digital signature (not to be confused with a digital 
certificate) is a method of validating the authenticity of a 
PDF or other document, that is, assuring the recipient that 
the document is valid and has not been tampered with. It 
also demonstrates that the sender has approved the 
contents of the document. The term “digital signatures” as 
discussed here does not mean the insertion of a jpg or 
other image of your scanned signature into a document, 
which essentially is no different than inserting any other 
image into a PDF and reflects no level of security or 
authenticity. 



Adding 
Digital 
Signatures 
to a Form

To add a Digital Signature field, choose the Digital 
Signature button from the Prepare Form toolbar or 
right-click on the document and choose Digital 
Signature from the menu. Place your cursor on the 
page where you wish the field to appear and left-click. 
It will prompt you to add a Field Name. A default 
name such as “Signature1” will appear in the box. You 
should not keep this default name, but rather, add a 
descriptive, meaningful name for the field.

If you check the box for Required Field, this field will 
have to be completed by the user for the form to be 
complete.



Adding Digital Signatures to a Form

• You can open the Digital Signature Properties box by double-clicking on the field or by right-
clicking and choosing Properties. There are five tabs that contain various properties that you 
can modify. Because many of the property tabs are similar to those displayed earlier in this 
Chapter, only those unique to these fields are displayed.

• General Tab: This tab displays the current name of the field, a Tooltip box, and options for 
whether to make the field Read Only or Required, whether the field should be visible either 
in screen or in print, and to rotate the field. Making a form field required will not allow a user 
to submit a form without adding information to the field. Adding text to the Tooltip will 
display text over the field when a user’s mouse pointer hovers over it. This device aids a 
user in knowing exactly what information, and in what format, should be typed in the box.

• Appearance Tab: This tab determines whether the field has a border or a fill color, the 
properties of the border such as color and thickness, and in which font and font size the 
text a user types will display.

• Position Tab: This tab determines the placement of the field on the page in terms of inches, 
points, etc. This property can be used to ensure that your fields are aligned or that they are 
in the same position as other text on the page.



Adding Digital Signatures to a Form

• You can open the Digital Signature Properties box by double-clicking on the field 
or by right-clicking and choosing Properties. There are five tabs that contain 
various properties that you can modify. Because many of the property tabs are 
similar to those displayed earlier in this Chapter, only those unique to these fields 
are displayed.

• Actions Tab: This tab allows you to associate actions with the form field such 
as moving the user to a specific page, opening a file, or opening a web page. 
You can also use an action to submit the form when the user completes the 
final field. To add an action, you choose the trigger (Mouse Down is a click, 
Mouse Up is releasing after a click, Mouse Enter is moving the pointer over the 
button, and Mouse Exit is moving the pointer away from the button) and then 
use the Add button to add the desired action. For example, you may want to 
use a “Submit” button so that the user can automatically submit (return) the 
document to you by email.



Adding Digital 
Signatures to a Form

• You can open the Digital Signature Properties box by double-
clicking on the field or by right-clicking and choosing Properties. There 
are five tabs that contain various properties that you can modify. 
Because many of the property tabs are similar to those displayed 
earlier in this Chapter, only those unique to these fields are displayed.

• Signed Tab: This tab determines what happens when the 
document is signed by a user. The default is Nothing happens 
when signed, but you can choose other options to mark the 
document as read-only or to execute a script.

• Locked Button: This choice appears on the bottom of each tab. 
If you check this box, the form field properties cannot be 
changed. Checking the box on one tab locks the options on all of 
the other tabs. If you need to make changes to the field 
properties, simply uncheck the box.
• You can change the properties of multiple fields at one time 
by Ctrl-clicking or Cmd-clicking on the fields, right-clicking on 
one field, and choosing Properties. Note that depending on the 
properties of the fields you select (the type of field, etc.), all of 
the options will not be available.



Additional Options for Modifying 
Fields through Right-Clicking

• You can modify the field’s properties or add a new field by using the tools 
for each field type, but also by right-clicking on a field. Right-clicking provides 
quick options for accessing the Properties, Rename Field, Set as Required 
Field, or Add New Field options, as well as copying or deleting fields. There is 
also an option to Use Current Properties as New Defaults. If you modify 
properties for a specific type of form field such as a Check Box, and then 
choose the option to Use Current Properties as New Defaults, those 
properties will be saved as the defaults for any new fields of that type you 
insert in the form.
NOTE: Changing default properties will not change the settings for existing 
form fields, only new ones.



The Forms Pane

• The Forms pane allows you to navigate easily through 
the fields that are on the page and reorder them. It also 
provides additional tools that allow you to format the 
fields on the page. 

• Aligning and Centering Multiple Fields: [1] You can align 
a column of fields on a page left, right, or vertically. You 
can align a row of fields on a page by the top, bottom, 
or horizontally. Additionally, you can center the fields 
vertically, horizontally, or both.

• Adjusting Spacing between Form Fields: [2] You can use 
the Distribute command in the Forms pane to give a 
group of fields uniform spacing measuring from the 
centers of the fields. To distribute fields evenly between 
the topmost and bottommost fields, choose Distribute 
Vertically. To distribute fields evenly between the leftmost 
and rightmost fields, choose Distribute Horizontally.



The Forms Pane

• Other tools are available to you when creating or 
modifying forms in Other Forms Tasks (the “More” 
section), located on the Forms pane above the Fields 
List. Some of the tools are only available when a field is 
selected; others are available at all times. Some of the 
more useful tools are discussed below. 
• Duplicate across Pages: When you have a field or 

fields selected, this tool allows you to duplicate the 
field(s) on all or selected pages. If you do not 
change the names of the copied fields, the new 
fields will be populated with the same data as in the 
original field. If the new fields are for different user 
data, they must be renamed once created.



The Forms Pane
• Other tools are available to you when creating or 

modifying forms in Other Forms Tasks (the “More” 
section), located on the Forms pane above the Fields 
List. Some of the tools are only available when a field 
is selected; others are available at all times. Some of 
the more useful tools are discussed below. 
• Create Multiple Copies: When you have a field or 

fields selected, this tool allows you to create 
copies of the field(s) any number of times you 
choose. If you do not change the names of the 
copied fields, the new fields will be populated with 
the same data as the original field. If the new 
fields are for different user data, they must be 
renamed once created.

• Show Tab Numbers: This tool allows you to 
change the order in which a user will be directed 
to fill a field. The fields will show the tab order.



The Forms Pane
• Other tools are available to you when creating or 

modifying forms in Other Forms Tasks (the “More” 
section), located on the Forms pane above the Fields 
List. Some of the tools are only available when a field is 
selected; others are available at all times. Some of the 
more useful tools are discussed below. 
• Show Field Properties: This tool is another method 

of showing the properties of selected fields.
• Highlight Existing Fields: This tool makes finding 

fillable fields easier for a user by causing the fields to 
appear with a colored background.



The Forms Pane
• Other tools are available to you when creating or modifying 

forms in Other Forms Tasks (the “More” section), located on the 
Forms pane above the Fields List. Some of the tools are only 
available when a field is selected; others are available at all 
times. Some of the more useful tools are discussed below. 
• Import Data, Export Data, and Merge Data Files into 

Spreadsheet: These tools are used when the form contains 
a Submit Form action that exported the form data into FDF, 
HTML, or XFDF format. This option is available to firms that 
desire to only export the data and not preserve the forms. 
Most firms will not use this option. For more information, go 
to https://helpx.adobe.com/acrobat/using/collecting-pdf-
form-data.html.

• Distribute and Track: These tools allow you distribute a 
form for completion and to track the return of forms; they 
are discussed more fully in the following two sections.



Enabling Users to Fill Forms 
Out Without Tracking 
(Reader Extend PDFs)

• Most of the time, you will be sending 
forms to clients or others without the 
need to track every form. For 
example, a client may contact you 
about preparing a Will, Living Will and 
Power of Attorney, and you have an 
office Questionnaire that requests the 
information needed to begin preparing 
these documents. It is easier for you 
and the client to have the information 
in a typed form. Doing so eliminates a 
lot of the need to ask for backgournd
information, and prevents misspellings 
of names, etc.



Enabling Users to Fill Forms 
Out Without Tracking 
(Reader Extend PDFs)

•Acrobat converts any form into a fillable PDF that does not 
require the end user to have a paid version. In other 
words, all they need is the free Acrobat Reader or a similar 
product. To enable that feature, go to File>Save as 
Other>Reader Extended PDF. There are two types of 
Reader Extended PDFs, one that enables commenting and 
measuring and the other that can be filled and saved. If 
you want to allow users to fill and save the document, you 
will view the Enable Usage Rights in Adobe Acrobat Reader 
dialog. When you click Save Now on this dialog, users can 
save form data, digitally sign a PDF and add comments. To 
prevent overwriting the original form, Acrobat will ask you 
to save the document with either a new name or in a 
different location from the original. Once you save the 
document, you cannot modify it.



Filling Out PDF Forms

• PDFs have two types of forms: PDFs with form fields and PDFs 
without form fields. You can convert the form into a fillable form, 
and should do so if you will use the form again. If you are only 
using the form one time (for example, you are emailed a form to 
complete and you do not anticipate having to do so again), then 
you can use what was formerly known as the Typewriter tool, 
now known as Add Text, which is located by Selecting Tools>Edit 
PDF. See “Adding Text in an Existing PDF (Formerly Known as the 
Typewriter Tool)” in Chapter 6.



Filling Out PDF Forms When You Must 
Use the Original Paper Document

There are times when you will need to fill in a form or other document and you must 
use the original paper form or document, not a copy that you generate and print on 
generic paper from your own printer. For example, if you need to create a corporate 
kit and have the original binder and pages, you need to fill in the information on the 
actual paper contained in the binder. In these instances, you do not need to use a 
typewriter.
• First, you can scan the original paper document and create a PDF. After creating 
the PDF, you can either convert the document into a PDF fillable form or manually 
add form fields. Fill out the forms fields and then load the original paper document 
into your printer’s paper tray and print the PDF using (1) the “Form Fields only” 
option in the Comments & Forms section, and (2) the “Actual size” option of the 
Page Sizing & Handling section of the Print dialog box.



Filling Out PDF Forms When You Must 
Use the Original Paper Document

• NOTE: Before printing the final version of the document, you 
should print a test page on blank printer paper to ensure that the 
information you typed will be printed in the correct locations on the 
document. You can usually determine this by holding the typed 
document over the original form and viewing it in front of a light 
source. In addition, make sure you load the original documents 
correctly in your print trays (loaded so that page one pulls into the 
printer first, paper face up or face down, paper with top to the 
back of the tray or to the front).
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Creating, Modifying, and Working with 
Forms in Adobe Acrobat DC 

Every law office uses forms, whether they are government documents clients must 
complete or an intake questionnaire created in Word. In a law office, forms are 
also useful for obtaining information from clients or standardizing documents. The 
problem with forms is that many offices still open a form, print it out, and then fill 
it in either by hand or by typing the necessary information. Adobe Acrobat allows 
you to create fillable forms from existing PDF documents.

Adobe Acrobat eliminates the hassle of manually completing forms by allowing 
users to transform virtually any document into a form that can be filled out or into 
a form that can be used over and over. Consider various Social Security forms. For 
example, every lawyer who represents a Social Security disability claimant must 
prepare various forms and submit them to the Social Security Administration. By 
converting the static forms into ones with fillable form fields, you can avoid typing 
all of the firm and attorney information every time and save time in the process.

Forms can be modified in a number of ways, distributed, and tracked. This 
chapter outlines many of the basics and some advanced aspects of creating Acro-
bat forms, which can even be used by persons who only have the free Acrobat 
Reader or are using the mobile Acrobat Reader app. For more advanced informa-
tion about creating forms, visit the Acrobat Help area of the program. There are 
also many excellent YouTube videos to assist. 

Converting PDF Files to Interactive Forms

You can convert any type of PDF into a fillable form, whether it is an existing form 
that you have scanned or a document you first created in Microsoft Word that you 
wish to make into a fillable form. First, open your PDF file and from the Tools 
pane, select Prepare Form. The only exception are PDFs with security settings that 
prohibit changing the document.

Acrobat will offer three options: Single File, Scanner, or Create New. (Figure 
10-1) Generally, Acrobat displays the document you are working on and its name
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above the Change File option. If this is the correct document, click Start. If you 
select Change File, you can use Windows File Explorer or Mac Finder to browse 
and locate the file you want to convert into a form. When the correct document is 
displayed, click Start.

If you select “Scanner,” a scanner-like interface appears. Once you scan a docu-
ment, Acrobat will begin the process of creating a form. Finally, “Create New” will 
open a new blank document, which can be used to create a form “from scratch.”

Note: We recommend scanning and saving any paper documents you want to con-
vert into a form before attempting to create a fillable form. This will allow you to create 
the form and then work with it, discarding any changes if you discover that you need to 
start over.

After you select Start, Acrobat will analyze the document and add form fields 
where it feels they are appropriate based on the text of the document and its analy-
sis of locations with blank lines. (Figure 10-2) 

Note: This autodetection is set by default. You can check this default setting, and 
change other settings, by modifying Forms preferences in Edit>Preferences>Forms 
for Windows or Acrobat Pro DC>Preferences for Mac.

The Prepare Form toolbar appears above your document, and the Forms pane 
will display to the right. The Prepare Form toolbar contains the tools for creating 
different types of fields, the Pin tool, a Help button, and a Preview button, which 
allows you to view the form as it will display to an end user and then easily go 
back into Edit mode. 

The Forms pane displays a list of the fields that Acrobat has added. (Figure 
10-3) Adjacent to the FIELDS title are two dropdown menus. The right dropdown
sorts your tabs (form fields) alphabetically or in tab order. The left dropdown menu

Figure 10-1
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is the Reading Order tool, which allows you to specify in what order users will go 
as they move between tabs. If you enable Show Tab Numbers, it may be easier to 
arrange tabs as you edit the document. You can sort (Order) the tabs (form fields) 
by Structure, by Row, or by Column to make it easier for the end user. 

Figure 10-2

Figure 10-3
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When you review the document and the form fields that Acrobat has inserted, 
you will likely note that Acrobat has inserted fields where you do not need them 
or has not inserted them where you do need them. You can manually add form 
fields by using the tools on the Prepare Form toolbar or by right-clicking on the 
document and choosing one of the field types from the menu. You can easily delete 
fields by selecting the field and pressing the Delete key or by right-clicking on a 
field and choosing Delete.

Note: If a document has been password protected to prevent editing, or Reader-
Enabled, you will not be able to add new fields or modify the existing fields.

Types of Form Fields (The types of fields correspond  
to the numbers listed under the fields in Figure 10-4.) 
(Figure 10-4)

■ Edit Text & Images: [1] This allows editing of text and images.
■ Add Text: [2] This tool allows you to add text directly to the file.
■ Text Field: [3] This tool allows users to type alphabetic or numeric

characters.
■ Check Box: [4] This tool presents choices for the user; multiple check

boxes can be selected if the form allows it.
■ Radio Button: [5] This tool presents choices for the user; only one radio

button can be selected (for example, to choose yes or no).
■ List Box: [6] This tool displays a list of options a user can select; you can

enable a user to select multiple items from the list.
■ Dropdown List: [7] This tool allows a user to choose an item from a pop-

up menu.
■ Button: [8] These action buttons allow a user to perform functions such

as Print, Reset, or Submit a form. They can also be used to perform other
actions, such as moving the user to a specific page, opening a file, or open-
ing a web page.

■ Image Field: [9] The image field allows the user to select an image to
upload and include in the document.

■ Add a Date Field: [10] The Add a Date field is the same as a text field that
requires the user to input a date in a specific format, without the extra
steps.

■ Digital Signature: [11] This tool allows a user to digitally sign a document.

Figure 10-4
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■ Barcode Field: [12] This tool encodes the data that is inputted on a form
and creates a barcode. This field is not likely to be used by attorneys and
will not be discussed in this book.

Note: Whenever you add a form field to a document, you always have a 
Properties box that provides you with multiple options and settings for the 
form field. Because these properties boxes and options are so similar for 
all types of form fields, we are not showing what each looks like, but you 
should review the properties when you add form fields to ensure that your 
fields display the way you want them to.

Using Text Fields

Most legal professionals will use text fields in every document. Learning how to 
create and modify them is crucial to creating documents that not only look good 
but are also user-friendly.

To add a text field, choose the Text Field button from the Prepare Form toolbar 
or right-click on the document and choose Text Field from the menu. (Figure 10-5 
and Figure 10-6) Place your cursor on the page where you wish the field to appear 
and left-click. A box will appear that will prompt you to add a Field Name. A default 
name such as “Text1” will appear in the box. You should not keep this default name 
but should instead add a descriptive, meaningful name for the field. (Figure 10-7)

Figure 10-5

Figure 10-6
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Note: If fields have the same name, when users type into the form field, the text 
they type will populate in the other fields with the same name. This can be useful 
if the form has areas where text needs to be repeated (such as a name, address, 
birthdate, etc.). Be careful when naming your fields to choose unique names that 
are not already in use in the document.

If you check the box for “Required field,” the user must fill in the field.
If the field is not properly sized, you can drag the handles on the field to the 

correct size.
You can open the Text Field Properties box by double-clicking on the field or 

by right-clicking and choosing Properties. There are eight tabs that contain vari-
ous properties that you can modify. (Figure 10-8)

■ General Tab: This tab displays the cur-
rent name of the field, a Tooltip box, and
options for whether to make the field Read
Only or Required, whether the field should
be visible either in screen or in print, and
whether to rotate the field. Making a form
field required will not allow a user to submit
a form without adding information to the
field. Adding text to the Tooltip will display
text over the field when a user’s mouse
pointer hovers over it. This device aids a
user in knowing exactly what information,
and in what format, should be typed in the
box. (Figure 10-8)

■ Appearance Tab: This tab determines
whether the field has a border or a fill color,
the properties of the border such as color
and thickness, and in which font and font
size the text a user types will display. (Fig-
ure 10-9)

■ Position Tab: This tab determines the
placement of the field on the page in terms

Figure 10-7

Figure 10-8

Figure 10-9
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of inches, points, etc. This property can be used to ensure that your fields 
are aligned or that they are in the same position as other text on the page. 
(Figure 10-10)

	■ Options Tab: This tab determines the align-
ment (Left, Center, Right) of the text a user 
types as well as whether the text is spell 
checked. You can limit the number of char-
acters that can be typed and allow for mul-
tiline or scrolling of long text. The multiline 
option allows users to type hard returns in 
their text. Scrolling will allow a user to type 
a long string of text, but will not allow for 
hard returns. If a user types a string of text that exceeds the box, the text 
that exceeds the field’s dimensions will not be visible in the field. By check-
ing the box to Allow Rich Text Formatting, you can enable your users to 
add formatting such as bold or italics to their text. (Figure 10-11)

	■ Actions Tab: This tab allows you to 
associate actions with the form field 
such as moving the user to a specific 
page, opening a file, or opening a 
web page. You can also use an action 
to submit the form when the user 
completes the final field. To add an 
action, you choose the trigger (Mouse 
Down is a click, Mouse Up is releasing 
after a click, Mouse Enter is moving the 
pointer over the button, and Mouse Exit 
is moving the pointer away from the 
button) and then use the Add button to 
add the desired action. Although you 
can use this feature with a text field, it 
is more commonly used when inserting 
an action button, discussed later in this 
chapter. (Figure 10-12) 

	■ Format Tab: This tab automatically 
formats the information a user enters in 
a specific way. (Figure 10-13)

	❖ None: This option applies no 
formatting.

	❖ Number: This option provides num-
ber formatting options similar to 
those found in Microsoft Excel for 
decimal places, separators such as 

Figure 10-10

Figure 10-11

Figure 10-12
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commas and periods, currency symbols 
and locations of those symbols, and 
negative number style (with or without 
parentheses or red text).

❖ Percentage: This option provides for-
matting options for decimal places and
separators such as commas and periods.

❖ Date: This option provides formatting
options for various date styles, such as
m/d, mm/dd/yy, or yyyy-mm-dd. You can
also use a style that combines date and
time if you need to display both.

❖ Time: This option provides formatting
options for various time styles, such as
HH:MM or h:MM:ss tt (where tt is the a.m. or p.m. indicator). If you need
to combine date and time, you should use the Date formatting option.

❖ Special: This option provides formatting options for Zip Code, Zip Code
+4, Phone Number, and Social Security Number.

❖ Custom: This option provides further
options using JavaScripts. Most lawyers
will not need this option.

■ Validate Tab: This tab restricts entry in
a text field to specified ranges, values, or
characters. If you choose to use a number or
percentage format, for example, on the For-
mat tab, you can limit the entry to numbers
within a certain range. The option to limit
the range is grayed out when it does not
apply to your Format style. (Figure 10-14)

■ Calculate Tab: This tab performs math-
ematical operations on field entries and
displays the result. You can easily display
the sum of the value of various fields, or the
product of various fields. This can be used
for expense reimbursement forms where
you can easily calculate the amount to
be reimbursed by multiplying a predefined
mileage rate by the number of miles a user
inserts in a form. (Figure 10-15)

Figure 10-13

Figure 10-14

Figure 10-15
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How to set up calculated fields:1 

To add text fields
1.	� Double-click the field where you want to display the result to 

open the Properties dialog box.
2.	 Click the Calculate tab.
3.	� To add the values entered into fields, click the “Value is the” 

radio button.
4.	 Pick Sum from the pop-up menu.
5.	� Click Pick to open a list of the fields in your form, select the 

fields you want to add, and click OK to list the fields in the 
dialog box.

To multiply values
1.	� Double-click the field where you want to display the result to 

open the Properties dialog box.
2.	 Click the Calculate tab.
3.	� To multiply the values entered into fields, click the “Value is 

the” radio button.
4.	 Pick Product from the pop-up menu.
5.	� Click Pick to open a list of the fields in your form, select the 

fields you want to multiply, and click OK to list the fields in 
the dialog box.

To subtract one field from another
1.	 Open the Properties for the results field.
2.	 Click the Calculate tab.
3.	 Now click the Simplified Field Notation radio button.
4.	 Click Edit to open the Javascript Editor.
5.	� Type the expression in the editor, such as Field1-Field2. Make 

sure not to add any spaces.
6.	� Click OK and you’ll see the expression show on the dialog 

box.

To divide two fields
1.	� In the Calculate tab for the results field, choose Simplified 

Field Notation, and click Edit.

1.  These instructions for creating calculated fields are from https://acrobatusers.com/tutorials 
/how-do-i-use-basic-calculations-in-a-form/, which offers excellent guidance on these operations, and 
many other Adobe Acrobat features and functions.
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2.	� In the JavaScript Editor, type FieldB/FieldA. Again, make 
sure you don’t have any spaces. Click OK and you’ll see the 
expression on the Properties dialog box.

3.	� Click Preview to toggle the Preview mode to test your work. 
You won’t have any surprises with adding, subtracting, or 
multiplying, but a division calculation can cause display 
problems.

	■ Locked Button: This choice appears on the bottom of each tab. If you 
check this box, the form field properties cannot be changed. Checking the 
box on one tab locks the options on all of the other tabs. If you need to 
make changes to the field properties, simply uncheck the box.

You can change the properties of multiple fields at one time by Ctrl-
clicking or Cmd-clicking on the fields, right-clicking on one field, and 
choosing Properties. Note that, depending on the properties of the fields 
you select (the type of field, etc.), all of the options will not be available.

Using Check Box Fields

To add a check box field, choose the Check Box Field button from the Prepare 
Form toolbar or right-click on the document and choose Check Box from the menu. 
Place your cursor on the page where you wish the field to appear and left-click. A 
box will appear that will prompt you to add a Field Name. A default name such as 
“Check Box1” will appear in the box. You should not keep this default name but 
rather add a descriptive, meaningful name for the field. (Figure 10-16)

Figure 10-16

Note: If fields have the same name, when users type into the field, the text 
they type will populate in the other fields with the same name. This can be useful 
if the form has areas where text needs to be repeated (such as a name, address, 
birthdate, etc.). Be careful to choose unique names when naming your fields to 
avoid using names that are already in use in the document.

If you check the box for Required Field, this field will have to be completed by 
the user for the form to be complete.
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If the field is not properly sized, you can drag the 
handles on the field to the correct size.

You can open the Check Box Properties box by 
double-clicking on the field or by right-clicking and 
choosing Properties. There are five tabs that contain 
various properties that you can modify.

■ General Tab: This tab displays the current
name of the field, a Tooltip box, and options
for whether to make the field Read Only or
Required, whether the field should be visible
either in screen or in print, and whether to
rotate the field. Making a form field required
will not allow a user to submit a form without
adding information to the field. Adding text
to the Tooltip will display text over the field
when a user’s mouse pointer hovers over it.
This device aids a user in knowing exactly
what information, and in what format, should
be typed in the box. (Figure 10-17)

■ Appearance Tab: This tab determines
whether the field has a border or a fill color,
the properties of the border such as color and
thickness, and in which font and font size the
text a user types will display. (Figure 10-18)

■ Position Tab: This tab determines the
placement of the field on the page in terms
of inches, points, etc. This property can be
used to ensure that your fields are aligned
or that they are in the same position as other
text on the page. (Figure 10-19)

■ Options Tab: This tab determines the
Check Box style (whether the user’s choice
is displayed as a checkmark, a circle, a star,
etc.) as well as whether the box should be
checked by default or not. The Export Value
is set as Yes by default, but depending
on what the check box signifies, you can
change this value. (Figure 10-20)

■ Actions Tab: This tab allows you to associate
actions with the form field such as moving
the user to a specific page, opening a file,
or opening a web page. You can also use an

Figure 10-17

Figure 10-18

Figure 10-19

Figure 10-20
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action to submit the form when the user completes filling out the document. 
To add an action, you choose the trigger (Mouse Down is a click, Mouse Up 
is releasing after a click, Mouse Enter is moving the pointer over the button, 
and Mouse Exit is moving the pointer away from the button) and then use 
the Add button to add the desired action. 
Although you can use this feature with 
a Check Box field, it is more commonly 
used when inserting an action button, 
discussed later in this chapter. (Figure 
10-21)

■ Locked Button: This choice appears
on the bottom of each tab. If you
check this box, the form field properties
cannot be changed. Checking the box
on one tab locks the options on all of
the other tabs. If you need to make
changes to the field properties, simply
uncheck the box.

You can change the properties of 
multiple fields at one time by Ctrl-
clicking on the fields, right-clicking on 
one field, and choosing Properties. Note 
that depending on the properties of the 
fields you select (the type of field, etc.), 
all of the options will not be available. 
(Figure 10-22)

Using Radio Button Fields

A radio button requires users to select one entry from a predefined set of two or 
more options. Thus, you must always add at least two radio buttons to a document.

■ To add a radio button field, choose the Radio Button Field button from
the Prepare Form toolbar or right-click on the document and choose Radio
Button from the menu. Place your cursor on the page where you wish
the button to appear and left-click. A box will appear that will remind
you that when using radio buttons, you must have more than one. It will
prompt you to add a Radio Button Choice Name. A default name such as
“Choice1” will appear in the box. You should not keep this default name
but rather add a descriptive, meaningful name for the field. You will then
enter a name for the Group Name. You then click the Add Another But-
ton link, place your cursor on the page where you wish the second radio

Figure 10-21

Figure 10-22
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button to appear, and provide a name for this choice. You should confirm 
that the Group Name is the same as was listed for your first radio button. 
All radio buttons in a set must have the same Group Name. (Figure 10-23)

Figure 10-23

If you check the box for “Required field,” this field will have to be com-
pleted by the user for the form to be complete.

You can open the Radio Button Properties box by double-clicking on 
the field or by right-clicking and choosing Properties. There are five tabs 
that contain various properties that you can modify.

	■ General Tab: This tab displays the current name of the field, a Tooltip box, 
and options for whether to make the field Read 
Only or Required, whether the field should be 
visible either in screen or in print, and whether 
to rotate the field. Making a form field required 
will not allow a user to submit a form without 
adding information to the field. Adding text to 
the Tooltip will display text over the field when 
a user’s mouse pointer hovers over it. This 
device aids a user in knowing exactly what 
information, and in what format, should be 
typed in the box. (Figure 10-24)

	■ Appearance Tab: This tab determines 
whether the field has a border or a fill color, 
the properties of the border such as color and 
thickness, and in which font and font size the 
text a user types will display. (Figure 10-25)

	■ Position Tab: This tab determines the placement 
of the field on the page in terms of inches, 
points, etc. This property can be used to ensure 
that your fields are aligned or that they are in 
the same position as other text on the page. 
(Figure 10-26)

Figure 10-24

Figure 10-25
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	■ Options Tab: This tab determines the Radio 
Button Style (whether the user’s choice is 
displayed as a checkmark, a circle, a star, 
etc.) as well as whether the button is checked 
by default or not. (Figure 10-27)

	■ Actions Tab: This tab allows you to associate 
actions with the form field such as moving 
the user to a specific page, opening a file, 
or opening a web page. You can also use 
an action to submit the form when the user 
completes the final field. To add an action, 
you choose the trigger (Mouse Down is a click, 
Mouse Up is releasing after a click, Mouse 
Enter is moving the pointer over the button, 
and Mouse Exit is moving the pointer away 
from the button) and then use the Add button 
to add the desired action. Although you can 
use this feature with a Radio Button field, it is 
more commonly used when inserting 
an action button, discussed later in this 
chapter. (Figure 10-28)

	■ Locked Button: This choice appears on 
the bottom of each tab. If you check this 
box, the form field properties cannot be 
changed. Checking the box on one tab 
locks the options on all of the other tabs. 
If you need to make changes to the field 
properties, simply uncheck the box.

You can change the properties of 
multiple fields at one time by Ctrl-
clicking on the fields, right-clicking on 
one field, and choosing Properties. Note 
that depending on the properties of the fields you select (the type of field, 
etc.), all of the options will not be available.

Using List Box and Dropdown Fields

To add a List Box or a Dropdown field, choose either the List Box or Dropdown 
Field button from the Prepare Form toolbar or right-click on the document and 
choose the appropriate item from the menu. Place your cursor on the page where 
you wish the field to appear and left-click. A box will appear that will prompt you 
to add a Field Name. A default name such as “List Box 1” or “Dropdown1” will 

Figure 10-26

Figure 10-27

Figure 10-28
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appear in the box. You should not keep this default name but rather add a descrip-
tive, meaningful name for the field.

Note: If fields have the same name, when users type into the field, the text they 
type will populate in the other fields with the same name. This can be useful if the 
form has areas where text needs to be repeated (such as a name, address, birthdate, 
etc.). Be careful to choose unique names when naming your fields to avoid using 
names that are already in use in the document. Then you can complete the last 
sentence as it is duplicative.

If you check the box for Required Field, this field will have to be completed by 
the user for the form to be complete.

If the field is not properly sized, you can drag the handles on the field to the 
correct size.

You can open the List Box or Dropdown Properties box by double-clicking 
on the field or by right-clicking and choosing Properties. There are either six 
(List Box) or seven (Dropdown) tabs that contain various properties that you can 
modify. The tabs are generally common to both types of field. Because many of 
the property tabs are similar to those displayed earlier in this chapter, only those 
unique to these fields are displayed.

	■ General Tab: This tab displays the current name of the field, a Tooltip 
box, and options for whether to make the field Read Only, whether the field 
should be visible either in screen or in print, and whether to rotate the field. 
Making a form field required will not allow a user to submit a form without 
adding information to the field. Adding text to the Tooltip will display text 
over the field when a user’s mouse pointer hovers over it. This device aids 
a user in knowing exactly what information, and in what format, should be 
typed in the box.

	■ Appearance Tab: This tab determines whether the field has a border or a 
fill color, the properties of the border such as color and thickness, and in 
which font and font size the text a user types will display.

	■ Position Tab: This tab determines the placement of the field on the page 
in terms of inches, points, etc. This property can be used to ensure that 
your fields are aligned or that they are in the same position as other text 
on the page.

	■ Options Tab: This tab is the vital one for creating a list. In the line marked 
Item, you type the various choices for the list. You then click Add to add 
them to the Item List below. If you wish to remove an item, simply highlight 
it and click Delete.

The Item List displays the choices available to the user. The item that 
appears highlighted on the list is the default choice. Depending on your 
form’s purpose, you may want to add a None choice to your list. The Up 
and Down buttons allow you to reorder the list display, or you can click 
the Sort Items box to quickly alphabetize or numerically sort your list.
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Clicking the Multiple Selection option (only available when using the 
List Box field) allows users to choose more than one item. Clicking the 
box Commit Selected Value Immediately saves the value as soon as a user 
selects it rather than only when the user moves to another field.

Clicking the Allow User to Enter Custom Text and Check Spelling 
options (only available when using the Dropdown field) allows a user to 
type text other than one of the presented choices and will spell check the 
entered text.

	■ Actions Tab: This tab allows you to associate actions with the form field 
such as moving the user to a specific page, opening a file, or opening a web 
page. You can also use an action to submit the form when the user com-
pletes the final field. To add an action, you choose the trigger (Mouse Down 
is a click, Mouse Up is releasing after a click, Mouse Enter is moving the 
pointer over the button, and Mouse Exit is moving the pointer away from 
the button) and then use the Add button to add the desired action. Although 
you can use this feature with a List Box or a Dropdown field, it is more com-
monly used when inserting an action button, discussed later in this chapter.

	■ Selection Change Tab (List Box only): This 
tab specifies what to do when the list box selec-
tion changes. You can choose Do Nothing or 
choose to execute a JavaScript. Most likely you 
will not use this function. (Figure 10-29)

	■ Format Tab (Dropdown only): This tab 
automatically formats the information a user 
enters in a specific way. (Figure 10-30)

	❖ None: This option applies no formatting.
	❖ Number: This option provides number 

formatting options similar to those found 
in Microsoft Excel for decimal places, 
separators such as commas and periods, 
currency symbols and locations of those 
symbols, and negative number style 
(with or without parentheses or red text).

	❖ Percentage: This option provides for-
matting options for decimal places and 
separators such as commas and periods.

	❖ Date: This option provides formatting 
options for various date styles, such as 
m/d, mm/dd/yy, or yyyy-mm-dd. You can 
also use a style that combines date and 
time if you need to display both.

	❖ Time: This option provides formatting options for various time styles, 
such as HH:MM or h:MM:ss tt (where tt is the a.m. or p.m. indicator). If you 
need to combine date and time, you should use the Date formatting option.

Figure 10-29

Figure 10-30
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	❖ Special: This option provides formatting options for Zip Code, Zip Code 
+4, Phone Number, and Social Security Number.

	❖ Custom: This option provides further options using JavaScripts. Most 
lawyers will not need this option.

	■ Validate Tab (Dropdown only): This tab restricts entry in a text field to 
specified ranges, values, or characters. If you choose to use a number or 
percentage format, for example, on the Format tab, you can limit the entry 
to numbers within a certain range. The option to limit the range is grayed 
out when it does not apply to your Format style. (Figure 10-31)

	■ Calculate Tab (Dropdown only): This tab performs mathematical 
operations on field entries and displays the 
result. You can easily display the sum of 
the value of various fields, or the product 
of various fields. This is useful for expense 
reimbursement forms where you can easily 
calculate the amount to be reimbursed by 
multiplying a predefined mileage rate by the 
number of miles a user inserts in a form. 
(Figure 10-32)

There is also a Locked Button (similar 
to what appears elsewhere in the program). 
This choice appears on the bottom of each 
tab. If you check this box, the form field 
properties cannot be changed. Checking the 
box on one tab locks the options on all of the 
other tabs. If you need to make changes to 
the field properties, simply uncheck the box.

You can change the properties of mul-
tiple fields at one time by Ctrl-clicking on 
the fields, right-clicking on one field, and 
choosing Properties. Note that depending 
on the properties of the fields you select (the 
type of field, etc.), all of the options will not be available.

Using Action Buttons

Buttons can open a file, play a movie or sound, submit information to a web server, 
or perform other functions that links and bookmarks do not. Every form field has 
an Actions tab that can execute the same types of functions as an action button. 
However, there are times when using an action button makes more sense, such as 
when you are providing an option to submit, print, or reset a form. Because many 
of the property tabs are similar to those displayed earlier in this chapter, only those 
unique to these fields are displayed. An action button can do the following:

Figure 10-31

Figure 10-32
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■ Activate a single action or a series of actions.
■ Change its appearance in response to mouse actions.
■ Be copied across many pages.
■ Mouse actions can activate different button actions. For example, Mouse

Down (a click), Mouse Up (releasing after a click), Mouse Enter (moving
the pointer over the button), and Mouse Exit (moving the pointer away from
the button) can all start a different action for the same button.
❖ To add an action button, choose the Button option from the Prepare

Form toolbar or right-click on the document and choose Button from
the menu. Place your cursor on the page where you wish the button to
appear and left-click. A box will appear that will prompt you to add a
Field Name. A default name such as “Button1” will appear in the box.
You should not keep this default name but rather add a descriptive,
meaningful name for the field.

Note: If fields have the same name, when users type into the field, 
the text they type will populate in the other fields with the same name. 
This can be useful if the form has areas where text needs to be repeated 
(such as a name, address, birthdate, etc.). Be careful to choose unique 
names when naming your fields to avoid using names that are already 
in use in the document.

If you check the box for Required Field, this field will have to be 
completed by the user for the form to be complete.

If the field is not properly sized, you can drag the handles on the 
field to the correct size.

You can open the Button Properties box by double-clicking on the 
field or by right-clicking and choosing Properties. There are five tabs 
that contain various properties that you can modify.
♦ General Tab: This tab displays the current name of the field, a

Tooltip box, and options for whether to make the field Read Only,
whether the field should be visible either in screen or in print, and
whether to rotate the field. Adding text to the Tooltip will display text
over the field when a user’s mouse pointer hovers over it. This device
aids a user in knowing exactly what information, and in what format,
should be typed in the box.

♦ Appearance Tab: This tab determines whether the field has a border
or a fill color, the properties of the border such as color and thickness,
and in which font and font size the text a user types will display.

♦ Position Tab: This tab determines the placement of the field on the
page in terms of inches, points, etc. This property can be used to
ensure that your fields are aligned or that they are in the same posi-
tion as other text on the page.

♦ Options Tab: This tab determines how your button is displayed:
as a Label only, an Icon only, or a combination of both in various
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configurations. Depending on which option you choose, you will be 
able to enter the text of the label and/or browse to your computer for 
an appropriate icon. A preview of the icon will appear in this win-
dow. The Advanced dialog allows you to change the way the icon is 
scaled to fit inside the button.

	♦ The Button Behavior determines how the button displays when 
clicked. None keeps the button appearance the same, Push specifies 
how the button looks as a mouse either hovers over or clicks the 
button, Outline highlights the button border, and Invert reverses the 
dark and light shades of the button.

	♦ Actions Tab: This tab allows you to associate an action with the 
button such as moving the user to a specific page, opening a file, or 
opening a web page. You can also use an action to submit the form 
when the user completes the final field. To add an action, you first 
choose the trigger. Mouse Down is a click, Mouse Up is releasing 
after a click, Mouse Enter is moving the pointer over the button, and 
Mouse Exit is moving the pointer away from the button. In most 
cases, you will want to use Mouse Up. There are other triggers, such 
as Page Visible and Invisible, Page Enter and Exit, and On Focus, 
that are used only with media clips; however, you will not customar-
ily use these triggers, so we only briefly mention them here. 

You will then use the Add button to add the desired action such 
as opening a web page, submitting the form, or resetting the form.

	■ Using the Submit a Form Action (Figure 10-33)
The “Submit a form” action allows a user to click on a button and open 

an email window in a user’s default email client with a predetermined 
email recipient and the form as an attachment. The user then adds any 
message and sends the email to the prespecified email address.

	❖ When using the “Submit a form” action, you are prompted to enter a 
URL. (Figure 10-34)

Figure 10-33 Figure 10-34
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❖ You can collect form data either on a server or as attachments to email.
Which option you choose will depend on the purpose of the form. If
you are using the form to assemble data from a number of sources to
be merged together, you may want to use the server option. If you are
sending a form to a specific client and want to see the responses on the
form, you may want to use the email attachment option.
♦ To collect form data on a server, type the location in the “Enter a URL

for this link” box: for example, \\[server]\[folder]\[subfolder]\.
♦ To collect form data as attachments to email, type mailto: followed by

the email address: for example, mailto:nobody@techlawyergy.com.
❖ You would then choose the Export format (FDF, HTML, XFDF, or PDF,

which will return the entire file with user input). You can choose which
fields are returned and whether to convert dates into a specific format.
This tool is used when the form contains a “Submit a form” action that
exported the form data into FDF, HTML, or XFDF format. This option is
available to firms that desire to only export the data and not preserve the
forms. Most firms will not use this option. For more information, go to
https://helpx.adobe.com/acrobat/using/collecting-pdf-form-data.html.

❖ When you are finished, click Close.
Note: When sending a form or other document to another person for 

completion or for commenting, you must advise the recipient to save the 
document to his or her computer before completing the form or adding 
comments. If the recipient simply opens the email attachment without 
saving it, adds information, and merely hits the Save button, the docu-
ment will only be stored temporarily, the recipient will not be able to 
find the revised version, and all of the changes will be lost. Reopening 
the attachment opens the blank document again.

■ Locked Button: This choice appears on the bottom of each tab. If you
check this box, the form field properties cannot be changed. Checking the
box on one tab locks the options on all of the other tabs. If you need to
make changes to the field properties, simply uncheck the box.

You can change the properties of multiple fields at one time by Ctrl-
clicking or Cmd-clicking on the fields, right-clicking on one field, and 
choosing Properties. Note that depending on the properties of the fields 
you select (the type of field, etc.), all of the options will not be available.
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